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Chapter

What is TuneLab Pocket ?

TuneLab is software that helps you to tune pianos. This software comes in various forms: for laptops, Pocket
PCs, and Windows Mobile Smartphones. This manual describes TuneLab Pocket. There are separate manuals
to describe TuneLab for the other platforms.
Visual Tuning
TuneLab is one of the class of devices or software programs called “Visual Tuning Aids” or “Electronic
Tuning Devices”. These are devices or programs that provide a piano tuner with real-time guidance during
tuning. The sound of a note as it is played is picked up by a microphone and analyzed. The results of the
analysis are displayed in a visual pattern. In the case of TuneLab, there are two main visual patterns that are
displayed - the phase display and the spectrum display. Both of these displays indicate if the pitch of a note
should be raised or lowered, but each display has its own unique advantages. Having both displays visible
simultaneously gives the piano tuner the best of both worlds.
Phase Display
The phase display is the horizontal band shown here. This display is used for
fine tuning. The black squares move to the left if the note is flat and to the
right if the note is sharp. The closer you get to the correct tuning, the slower
the black squares will move. The goal is to make the black squares come as much to a stop as possible. If the
piano string has any false beats then the black squares may appear to move in an irregular fashion, sometimes
moving back and forth. When there is no note playing, or when the note being played is far from the correct
pitch, the black squares will disappear or move randomly.
This display is called a phase display because it displays the phase of the sound from the microphone as
compared to the phase of an internally generated reference pitch. The movement of the squares can be
compared to listening to beats between a tuning fork and a note on the piano. For the bass and midrange,
when a square makes one complete trip around the display, that corresponds to one complete beat that you
would hear when comparing two tones. For higher notes the display is artificially slowed down in order to
keep the speed of the display in a reasonable range.
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Spectrum Display
The spectrum display is the graph shown here with the zoom set to +/130 cents around the desired pitch. Using the Edit Options menu, you can
choose to make the traces thicker for easier visibility, at the cost of a some
loss of resolution. This display shows how the sound energy is distributed
across the frequency spectrum. If TuneLab is listening to a pure tone, then
the spectrum graph will show a single peak. The example seen here was made from an A-440 tuning fork that
was actually a little flat. The red line in the center of the display marks the correct pitch. The green lines nearest
the center mark the points that are 10 cents above and below the correct pitch. The green lines far from the
center mark the points that are 100 cents above and below the correct pitch, i.e. the previous note and the next
note. The object in tuning with the spectrum display is to tune the note until the peak of the graph is centered
on the red line.
The spectrum display has several advantages over the phase display. One is that it shows where the pitch of the
piano is, even when that pitch is far from the correct pitch. The other advantage is that the spectrum display
can show several peaks at once. This is what you would get when playing a poorly tuned unison:
Here the piano note C7 is being played with one string tuned nine cents
higher than the other two strings. In this display the zoom has been set to
its most zoomed-in level, +/- 50 cents. By looking at individual peaks it is
possible to tune notes in the high treble without mutes! You simply tune
one of the strings and watch which peak moves. You can move that peak
to the central red line and then that string will be at the correct pitch. However, tuning this way is not as
accurate as tuning by sounding one string at a time, because the multiple peaks tend to become blurred as they
merge into one another.
One advantage of the phase display is that it generally provides more resolution than the spectrum display,
except in the highest octave where the resolutions of the two displays are about the same. For this reason the
spectrum display is used for rough tuning and the phase display is used for fine tuning. False beats can confuse
the phase display, though. So the spectrum display is preferred even for fine tuning in the high treble. In any
case, both displays are available; so you can use whichever display seems to be giving the clearest indication.
Toolbar
TuneLab uses a toolbar for the most common functions. Here is the toolbar from TuneLab Pocket:

Open Tuning File - selects and load an existing tuning file
Save Tuning File - saves the current tuning in a file so it can be recalled later
Lower Partial - switches to the next lower partial for tuning
Higher Partial - switches to the next higher partial for tuning
Measure - measures inharmonicity or current pitch in over-pull (pitch raise) mode
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Tuning Curve - displays the tuning curve for adjustment or review
Lock Mode - begins locking on to the note by automatically adjusting the offset
Over-pull - enables/disables over-pull (pitch raise) mode
Sound Generation on/off - toggles between listening mode and sound generating mode
These buttons also have tooltips that appear if you touch and hold one of these buttons. For example, here is
what appears if you touch and hold the Tuning Curve button.
These tooltips remind you what the button does. If you just want
to see the tooltip, but do not want the button to take its designated
action, then before you lift up the stylus, drag the stylus off of the
toolbar button. Otherwise, when you lift up the stylus, the button will do what it is supposed to do.
Because of the limited screen size, only the most commonly used functions are provided in the toolbar. The
other functions are found in menus, as described in Chapter 7.
Current Settings Displays
In the middle of the main TuneLab display screen in
large letters there is a display of the currently
selected note and octave. Above the phase display
is a display of current settings. Usually most of
these fields are blank; but here is an example with all
the fields active. The first screen shows an ordinary
Portrait mode screen. The second screen shows the
format when the screen is in Landscape mode. The
third screen shows the format for the square screen
devices, such as the Palm Treo 700w. Here is a list
with a description of each of these fields. Notice
that the square screen format does not show the
offset due to the historical temperament (Temper
-3.91) because there is not enough room in that
format.

Portrait Screen (normal)

Landscape Screen

Square Screen (e.g. Palm Treo 700w)

Tuning File Name (Sample Petrof II) - the name of the tuning file currently in use
Temperament Name (Vallotti-Young well) - the name of the temperament file (if one is selected)
Over-pull Percentage (25%) - the current over-pull percentage (if over-pull mode is enabled)
Tuning Partial (2nd Partial) - which partial (or fundamental) is used for tuning the current note
Frequency (488.45 Hz) - the calculated frequency, taking into account all offsets
Over-pull (0.00) - the offset due to over-pull mode (or the temporary offset if over-pull is not selected)
Custom Stretch (2.30) - the custom offset (if any) manually programmed for the current note
Tuning Curve Stretch (-0.56) - the offset calculated from the tuning curve
Temperament Offset (-3.91) - the offset from the optional historical temperament in effect
Basic Offset (-17.00) - the offset (if any) applied to all notes uniformly
Note Switching (ManualNote) - tells which form of note switching is in effect (auto/manual/timed)
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Microphone Level Indicator
To help verify that your microphone is working properly, TuneLab provides
two different displays of the microphone level. The display on the left is
found by selecting the Help menu and then selecting About TuneLab
Pocket. When all is quiet, the level should be below 0.5%. Normal talking into the microphone should
produce a level of at least 50%. If the reported level is nowhere near these levels, then check the multimedia
settings in your Pocket PC’s Settings to see if some system volume control is improperly adjusted. If your
Pocket PC has Automatic Gain Control, then make sure it is turned on (unless you want to
measure sustain time). There is also a microphone level bar graph indicator at the right edge of
the spectrum display as shown to the right. When the vertical bar reaches the top of the
spectrum display, that corresponds to a mic level of 100%.
Tuning Curve Adjustment
The image to the left is of the tuning curve adjuster screen. The tuning
curve adjuster contains two different graphs. The upper graph is called
the tuning curve. The small vertical lines mark the C notes. For each
note from A0 to C8 the graph shows the calculated stretch in cents. It
is this calculated stretch that appears in the current settings display
under the name TCurve. There are three adjustment modes: fully
automatic, semi-automatic, and fully manual. Normally we recommend
the fully automatic mode, where the
adjustment arrows are replaced by
the word 'Auto', as shown to the
right. Tapping on any one of them will make the fully automatic
adjustment. The display shown on the left includes just four adjusting
arrows because the semi-automatic (Auto-A0-C8) option has been
selected. When this option is enabled, the extreme ends of the tuning
curve are adjusted automatically, leaving only the inner “shape”
adjustments for you to make. If the fully manual mode is enabled, then
four more adjusting arrows would appear as shown here and you would
have to adjust the endpoints of the tuning curve manually.
The lower graph is called the deviation curve. It displays information about the two intervals that are selected
in the selection boxes just above the graph. As shown we have selected 6:3 octaves for the bass and 4:1 double
octaves for the treble. Other intervals may be selected, depending on the kind of tuning you want to achieve.
The deviation curve is divided into a left half and a right half. The left half is based on the interval selected for
the bass (6:3 octaves in this case) and the right half is based on the interval selected for the treble (4:1 double
octaves in this case). The deviation curve shows how far these intervals deviate from being pure if the current
tuning curve is followed. Where the deviation curve shows zero, the selected interval is beatless. In the graph
shown above, for example, the 4:1 double octave from C6 to C8 is beatless because the graph at C8 is at zero.
Where the deviation curve shows a positive number of cents, the selected interval is wider than beatless by that
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many cents. In the graph shown above, for example, the deviation curve at C5 appears to be at about 0.2 cents.
That means the 4:1 double octave from C3 to C5 will be wider than pure by about 0.2 cents. Where the
deviation curve shows a negative number of cents, the selected interval is narrower than beatless by that many
cents. In the left portion of the graph shown above, we see that the deviation curve at C4 appears to be at
about -0.4 cents. That means the 6:3 octave from C4 to C5 will be narrower than pure by about 0.4 cents.
Notice that intervals in the left part of the deviation curve are referred to by the lower of the two notes of the
interval, while intervals in the right part of the deviation curve are referred to by the upper of the two notes of
the interval. You can look at the deviation curve to evaluate any particular tuning curve adjustment, even if that
adjustment was done automatically by TuneLab.
When you use the adjuster arrows to adjust the tuning curve, or if TuneLab makes the adjustment for you
automatically, you are directly affecting the tuning curve. As a consequence of your adjustment of the tuning
curve, the deviation curve will also change. Therefore, even though you are directly adjusting the tuning curve,
you may assume that you are adjusting the deviation curve as well. Generally, you make your adjustments to
achieve a certain appearance in the deviation curve. The procedure for making these adjustments is described
in detail in Chapter 2.
Partials
Each note is tuned according to its fundamental pitch or the pitch of one of
its partials. The current settings box shows which partial is being used. The
selection of partials comes from a table of partials. This table may be
modified from the screen shown here. The table shows the partial number
for each note from A0 to B6. (C7 through C8 are assumed to be using the
fundamental.) Using the < and > buttons you can lower or raise the
partial for the highlighted note. You can highlight a different note by
tapping on the partial number for that note. Since the same partials are
generally used by a group of notes, the Dup button is provided to duplicate
the highlighted partial into the next note and advance the highlight. In this
manner you can quickly set an entire section of notes to the same partial.
The table of partials is stored along with the tuning curve in the tuning file
when you save a tuning. So it is possible to customize the table of partials
for each piano that you tune. Whenever you begin a new tuning, the table
of partials is initialized from the special tuning file, DEFAULT, which is installed when you install TuneLab.
If you want to make a change to the table of partials that will apply to all new tuning files that you create, then
you can explicitly load DEFAULT as a tuning file, edit the table of partials, then save the modified
DEFAULT, which will replace the original DEFAULT. Partials can also be changed on-the-fly using the
toolbar buttons described earlier. These on-the-fly changes are not stored in the table of partials and are
canceled when a new note is selected, unless you have enabled “Persistent Partials” under Edit Options, in
which case changes made on-the-fly are immediately incorporated into the current tuning file.
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Inharmonicity
Inharmonicity is the name given to the phenomenon whereby the partials
of a piano string are not exact multiples of a fundamental frequency.
TuneLab assumes that the partials are offset from their exact whole-number
multiples of the fundamental by an amount that increases with the square of
the partial number and is proportional to the inharmonicity constant.
When TuneLab measures inharmonicity for a string, the pitches of all the
partials of that string are analyzed and an inharmonicity constant is
generated for that string. The inharmonicity constants are stored in the
tuning file when a tuning is saved. You don’t need to be concerned with
the actual values of the inharmonicity constants that you measure; but you
can see and edit them from the Edit menu using the screen shown to the
left. In a well-scaled piano you can expect to see the lowest inharmonicity
constants somewhere in octave 2. From there the inharmonicity constants
increase slightly as you move down to A0 and they increase substantially as
you move up to C8, as shown in the graph below. TuneLab uses the
specific samples that you collect to find a best-fit inharmonicity model for
the entire scale. Using this model, TuneLab makes all the calculations regarding how partials relate to one
another.

Typical Inharmonicity Values for a Kawai Grand

Over-pull Mode
When raising or lowering the overall pitch of a piano by a significant amount, you will find that the notes that
you tune first are changed by the time you are done tuning. This is due to the interaction of the string tensions,
primarily through the bridge and soundboard and the flexing of the plate. When an entire section of notes is
raised in pitch, the result is that the notes that were tuned first will tend to drop in pitch. Even the notes that
you tuned last will drop somewhat due to the delayed settling of tension in the wire.
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Over-pull tuning mode compensates for this change by setting tuning targets that are a calculated amount
beyond the desired pitch. In this way the change that occurs will leave the notes right where you want them.
In many cases using just one pass with over-pull tuning can take the place of tuning the piano twice. Over-pull
mode accomplishes this goal by making a quick one-second pitch measurement before you start tuning each
note. The collection of these measurements is called the “over-pull history”. The most recent portion of the
history list is displayed to the left of the selected note as shown below.

The main purpose in displaying this list is to provide verification that the over-pull calculations are based on
valid measurements. Sometimes during a pitch raise extraneous noise can trigger a false reading to be entered
into the history list. The false reading can be corrected by re-measuring the current note. When in over-pull
mode, the field normally used for the temporary offset is used to display the over-pull offset as shown earlier in
the current settings. Temporary offsets are not permitted in over-pull mode (although you can use the basic
offset for the same purpose). When over-pull mode is first entered you have an opportunity to adjust some
parameters that affect how over-pull is calculated. The parameter that is most often changed is the over-pull
percentage, and this can be done quickly while you are tuning by tapping the phase display. Tapping anywhere
on the right side raises the over-pull percentage one percent. Tapping anywhere on the left side lowers the
percentage by one percent.
Calibration
TuneLab should be calibrated before you trust its absolute pitch. Without calibration, TuneLab assumes a
nominal crystal oscillator frequency in its sound system and makes all pitch calculations from that assumption.
By doing a calibration you are refining that nominal value based on a comparison to a trusted pitch source.
You can do a rough calibration using a tuning fork, but your final calibration should be with some more precise
source, such as the NIST phone service described later. The result of a calibration is a knowledge of the actual
sample rate of the sound system, which is shown in the About box. Normally, calibration is done only once
when TuneLab is first installed on your Pocket PC. See the chapter on calibration later in this manual for
details on doing a calibration.

Hands-Free Note Switching
By tapping on the note switching mode in the Current Settings box you enable different forms of hands-free
note switching. There is auto note switching, which listens for and switches to nearby notes when it hears
them. There is timed note switching, which switches to the next note after a certain delay time. And there is
Auto Measure, which switches notes to sequence through a pre-defined list of notes that you want to measure
for inharmonicity when starting a new tuning file. When any of these forms of hands-free note switching is in
effect, note switches are performed just as if they had been done manually. The current note switching status is
shown in the bottom center of the Current Settings box. Auto Measure is initiated by starting a new tuning file.
After the inharmonicity measurements are made, the note switching mode returns to whatever it was before.
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Auto note switching will switch up to three notes away from the current note. It can be enabled for up,
down, or both directions. When over-pull mode is also enabled, or when higher treble notes are selected, auto
note switching requires a “trigger”, which is a sudden rise in volume, such as you would get when playing a
note after some silence. At other times, auto note switching is less demanding, and will switch when the pitch
changes without a trigger event. If TuneLab doesn’t switch when you want it to, wait for some silence, and
then play the note again.
Timed note switching is useful primarily for doing a quick first pass pitch-raise. You can set the delay time in
Edit Options. If it is time to switch notes, but you are still playing the current note, then TuneLab will hold off
doing the switch because it will not switch until it hears a brief period of silence. You can pause timed note
switching by tapping on the current note display.
Auto measure is the mode that TuneLab uses when you start a new tuning file, provided you have previously
set up your list of preferred notes to measure under Edit Options. This mode is in effect only while you are
measuring inharmonicity. After the last note in your list has been measured, auto measure mode is
automatically canceled and the note switching mode returns to whatever it was before. After each note in your
list is measured, TuneLab switches automatically to the next note in your list and starts the inharmonicity
measurement for that note. If you should abort any measurement, TuneLab will not do any more sequencing
until you manually start another inharmonicity measurement.
Historical Temperaments
By default, TuneLab assumes an equal tempered scale. If you would like to tune in some unequal
temperament, you can select an historical temperament file to apply to your tuning. An historical temperament
file contains a list of 12 offsets for each of the 12 notes of an octave. When an historical temperament is
selected, one of these 12 offsets is used, depending on which note is selected. For any given note, the same
offset is used in every octave. In addition, the temperament offset may be optionally normalized. This means
that all 12 offsets will be shifted by the same amount before they are used. You can choose to have the offsets
normalized so that the offset for A is always zero; you can choose to normalize so that the average offset is zero
(to minimize the overall change from equal temperament); or you can choose to use the historical
temperaments just as they are with no normalization. The temperament name and the temperament offset for
the selected note appear in the Current Settings box shown previously. When you save a tuning the historical
temperament values (and temperament name) are saved in the tuning file. See the chapter on special functions
for information on making and using temperament files.
Tuning Files
A tuning file is a file made by TuneLab on your Pocket PC. It resides under the “My Documents” folder, and
it contains all the factors necessary to re-create a specific tuning. You can save the current tuning to a named
file, or open an existing tuning file by tapping on the file folder or diskette icons in the toolbar, as shown here.
If you want to organize your tuning files into several folders (like
“Churches” and “Homes” or “Grands” and “Verticals”) under the
one home folder, then you can create these other folders using the
File Explorer, a program supplied with your Pocket PC. See the Edit menu in File Explorer and choose
New Folder. After the folder has been created, it will appear as a choice in the Save File dialog box.
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Here is what a tuning file contains:
•
•
•
•
•

The inharmonicity constants for all the notes that you measured.
The adjustment of the tuning curve (the template).
The name of the historical temperament (if any) and all 12 offsets from that temperament.
The partial and custom offset (if any) for each of the 88 notes.
The selection of bass and treble intervals in the tuning curve adjuster.

Tuning File Comments
With every tuning file you have the option to store comments about that tuning, such as notes about needed
repairs or when to call that customer again. Any time you load a tuning file you can easily review the comments
that you had previously entered regarding that piano. The comments are stored in a separate document file
with the same name as the tuning file, but with a RTF extension. TuneLab automatically links up the two files
by name so that the correct comments are displayed when you select Comments in the View menu. TuneLab
creates each new comment file by copying the TL-COMMENT-FORM.RTF file, which is installed with TuneLab.
You can edit this file directly to customize the form of your comment files. If you should accidentally delete
this file, just create a new one using the Word program on your Pocket PC. Be sure to name it TL-COMMENTFORM and choose the Rich Text Format in Word to give it the .RTF extension. After viewing the comments in
Word, you can return to TuneLab by tapping twice on the x in the upper right. The first tap closes the
comment document and the second tap closes Word.
Sound Generation
Although the common use for TuneLab is in listening to notes and providing a visual tuning aid, you can also
use TuneLab as a tone generator. When TuneLab is in sound generation mode, the spectrum display and
phase display are disabled. The pitch of the sound generated in the speaker or headphones is the same as the
pitch that would have indicated correct tuning in the listening mode. The pitch is generated for whichever
partial is selected - not necessarily the fundamental. Sound generation using the fundamental of low pitches
may not be audible due to the limitations in the frequency response of the speakers found in Pocket PCs.
Sound generation is generally used to aid in stringing operations where precision is not as important as in
normal tuning. If you intend to use sound generation for precise tuning in TuneLab, you should be aware of
the fact that some Pocket PCs use two separate crystal oscillators in their sound output and sound input
operation. Therefore a separate calibration may be needed for the sound generation mode. So if you want the
same precision in tone generation as in listening mode, you should do the separate output pitch calibration as
described in the chapter on calibration. Even if your Pocket PC has only one sound crystal, it does not hurt to
do the separate calibration for the tone generation mode. If you don’t plan on using TuneLab to generate
tones, then you don’t need to do this special output calibration.
Note Selection
You can directly select any natural note (the white keys) by bringing up the popup keyboard and tapping on the
letter and number for the desired note and octave. The popup keyboard is controlled by the little keyboard
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icon in the lower right of the screen. The keyboard will disappear automatically after the octave number is
tapped. So you can select any natural note with just three taps - one to bring up the popup keyboard and two
to tap the letter and number for the desired note. To select a sharp note, start with the natural and then tap on
the “Note up” portion of the spectrum display as described below.
Imagine that the spectrum display is divided into four quadrants, as shown in the picture below. If you tap in
either of the upper two quadrants of the display, the octave number will change down or up. If you tap in
either of the two lower quadrants of the display, the note will change by one half-step up or down. When you
tap on any quadrant to change note, that quadrant will briefly turn all gray to indicate that the note is being
changed. That portion of the spectrum display will be refreshed on the next display update, which happens
about three times per second. But if you have turned on sound-generating mode, then the spectrum display is
not being refreshed, so the gray note changing indications will remain gray.
By using combinations of Octave Up, Octave Down, Note Up, and Note Down, you can select any note,
without using the popup keyboard. Here is the layout of the note-changing quadrants of the spectrum display:

You can also change notes using the 5-way Navigation Button, which is the rocker switch below the screen.
During a normal tuning it is most convenient to switch notes automatically using auto note switching.
During an extreme pitch raise, it may be more useful to use timed note switching.
Tuning Closeness Indicator
The current note display has a region on the bottom that indicates how close your tuning is to the target pitch.
Here are some examples:

more than one
cent off

slightly less than
one cent off

half a cent off

nearly
perfect

As these examples show, the gray bars start appearing when the tuning is within one cent of the target pitch;
they close down and meet in the center at zero cents.
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Chapter

Normal Tuning Procedure

This chapter takes you through a step-by-step tuning of a typical piano. To keep things simple at this point we
will assume this is not a pitch raise. If you need to do a pitch raise and want to use over-pull mode, first
become familiar with normal tuning and then go to the section on using over-pull mode. This description also
assumes that you have not tuned this particular piano before. If you had tuned this piano before and had saved
the tuning file then you could skip the initial setup and just load the saved tuning file and begin tuning.
Initial Setup
Tuning with an electronic tuning aid does not require strip muting the piano because there is no separate
“temperament setting” step as in aural tuning. You can tune with just two mutes. First check the condition of
the existing tuning to see if there are any major problems with the piano and to see if a pitch raise is necessary.
Assuming that a pitch raise is not necessary, the next step is to measure the inharmonicity of the piano.
When TuneLab is started it will have a tuning file name such as “untitled-1” in the current settings box. If you
have some other tuning file loaded as the current tuning you should clear out that tuning an begin a new tuning
file using the “New” menu. Select New Tuning File. This will clear out any old inharmonicity readings and
reset the table of partials to the default settings. You are now ready to develop a new tuning. Using the notes
specified in the “measure sequence” (found under Edit Options) TuneLab will guide you through the
process of making inharmonicity measurements for those particular notes. TuneLab will start by switching to
the first note in the sequence and then enable the first inharmonicity measurement automatically.
Measuring Inharmonicity
In order to form a model for the inharmonicity pattern of the specific piano you are about to tune, TuneLab
requires that you measure the inharmonicity of at least four notes and preferably five or six notes. If the piano
is a spinet that is known to have a large break in the inharmonicity, you may want to consider using the Split
Scale mode, as described in the Special Functions chapter. For now, we will assume that the piano is a wellscaled instrument that does not require Split Scale mode. Measuring more than eight notes is probably a waste
of time because it adds very little to the overall inharmonicity model. If the piano is a typical well-scaled
instrument, you can measure the C notes from C1 to C6. If one of these notes is hard to measure accurately
because of a serious false beat or lack of partials, then just measure some other nearby note instead. The graph
in Chapter 1 shows typical inharmonicity measurements of a Kawai 6’8” grand. In any case, when you measure
the inharmonicity of a note you should mute all but one string of the note. Measuring the inharmonicity of two
or three strings sounding at once is not recommended.
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To measure the inharmonicity of a note, select that note in TuneLab, as described in Chapter 1 under “Note
Selection”. (That selection may have been done for you if you had set up an auto measure sequence in Edit
Options.) Now that TuneLab is showing the note that you want to measure, if the measurement has not
already been initiated by the auto measure sequence, begin a measurement by tapping the “M” button on the
toolbar. This will cause a status box to appear showing “Measuring.., (trigger?)”. TuneLab will begin
listening to the note as soon as you play it. The sudden rise in sound level when you strike the note is the
trigger. If you do not play the note shortly after initiating a measurement it is quite likely that some extraneous
noise may trigger the sampling period and you will get a false reading. If this happens, just wait for the
calculation to finish and then discard the reading and start over. Or tap on the current note display to abort the
measurement immediately. If TuneLab is following the measure sequence for a new tuning, then you do not
need to switch notes or start each measurement because this will be done automatically for you.
When sampling for inharmonicity you should play the note that you want to measure and then watch the status
box change from “(trigger?)” to “(listening)”. This listening period is about six seconds for low notes and
progressively shorter for higher notes. If the piano is in good condition the sustain period of the note should
last to the end of the “listening” period. After the listening period is over the status display will switch to
“(calculating)”. At this time you can stop holding the note because TuneLab is no longer listening to it. After
a short calculation time TuneLab will display the results of the measurement. In some notes with too-soft
hammers, the partials are so weak that they cannot be measured. In that case it may be useful to pluck the
string with your fingernail rather than strike it using the key. If you pluck the string, pluck it near the
termination point to get a rich set of partials.
The most important measurement displayed in the results is the inharmonicity constant. The graph in Chapter
1 shows the typical pattern of inharmonicity constants for a Kawai 6’8” grand (model 650). Other pianos may
have more or less inharmonicity, but the pattern should be approximately the same. The graph stops at C6, but
in almost every case, the actual inharmonicity continues in the same pattern of rising inharmonicity established
by the lower octaves. So you can avoid measurements in the highest octaves and still have an accurate picture
of the inharmonicity of the piano.
When a measurement is complete, TuneLab displays a box like the one
shown to the left. Here we see that pitches were detected for the
fundamental and partials 2, 3, and 4. Some of partials 5-8 were detected,
but they were too weak to be used for measuring inharmonicity. The offset
column shows the offset in cents for the individual partials as compared to
what they would be if there were no inharmonicity. Generally there is more
inharmonic offset the higher you go in the partial series. The amplitude
column shows the relative strengths of the specific partials. TuneLab
analyzes the pattern of partial offsets and calculates an inharmonicity
constant for the string - in this case 0.742. If things look reasonable at this
point then you could tap on Save, which will save the inharmonicity
constant for the note C5. Or you can select Save,+ which will save the
measurement and began another measurement of the same note for
averaging. The “avg=0.65” shows that previous measurements have been
taken for this note, and the average so far, not including the current one, is
0.65. You can erase all measurements for this one note by tapping on the “avg=” display. At this point you
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can also view the partial amplitudes in graphical form by selecting Voicing from the menu bar. If you measure
inharmonicity again for the same note, the inharmonicity readings will be averaged. To stop all measurement,
select Discard and then tap on the Current Note display. Tapping on Discard will discard the current reading,
but it will also begin a new reading of the same note, so tapping on the Current Note display is necessary to
truly abort the measurement of inharmonicity.
Adjusting the Tuning Curve
Now that the inharmonicity readings have been taken, TuneLab can estimate the inharmonicity of all the notes
of the scale, not just the notes that you measured. Using that inharmonicity model, TuneLab can predict how
various intervals will sound. You can use that prediction to find an adjustment of the tuning curve that suits
you.
There are many ways to adjust the tuning curve and subjective value
judgments can play a role in how these adjustments are made. You get
to this screen by tapping on the Tuning Curve toolbar button , or
you may be brought here automatically at the conclusion of an auto
measure sequence. The “A7: 25.30” in the upper left reports on the
tuning curve value for A7. You can get the exact value for any point
on the tuning curve by tapping on it.
Normally we recommend fully automatic adjustment mode, shown
on the left, which you can select from the Edit menu, once the
adjuster screen is displayed. In that case you only need to select the
bass and treble intervals and then activate the automatic adjustment by
tapping on any one of the buttons labelled “Auto”..
If you choose the manual adjustment mode, then you must use the
adjuster arrows, shown on the right, to make the adjustments. The
arrows at the extreme left and right control the overall stretch in the
treble and the bass. The inner arrows control the shape of the bass and
treble portions of the tuning curve.
In the semi-automatic mode (also called Auto-A0-C8), as shown here,
the overall stretch is computed automatically, and so the corresponding
adjuster arrows are absent. But you still have to adjust the shape controls
using the remaining arrows.
Tapping on one of the up arrows moves a portion of the tuning curve in one direction while selecting the
corresponding down arrow moves that portion of the curve the other way. When you tap on the adjuster
arrows, the amount by which these adjuster buttons change the tuning curve varies depending on how the
buttons are used. If you hold any button down the amount of adjustment increases faster and faster the longer
you hold down the button. If you change between up and down the amount of adjustment decreases. So if
you want the adjustment to proceed faster, just hold down the desired button. If the adjustment is too fast,
then you will probably overshoot your goal, so you naturally will change to the opposite adjuster arrow. Doing
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so will reduce the size of the adjustment, so that you can adjust as finely as you want merely by changing
directions. To become familiar with how this all works, now might be a good time to experiment. Try holding
down one of the adjuster arrows until the adjustment reaches its limit and the word “limit” is displayed in place
of the arrow. Then hold down the opposite direction arrow until the adjustment reaches the limit in that
direction. Notice how a portion of the tuning curve moves as you vary the adjustment. Now experiment with
single taps on the adjustment arrows. Change direction several times. Notice how the adjustment becomes
finer and finer.
In the course of doing an adjustment you may find that a portion of the tuning curve goes off the scale. If this
happens and you want to see the whole curve, tap on Zoom in the menu at the bottom of the screen. This will
toggle the graphical limits between the original limits and the limits that exactly contain the current curve.
Now that you have become familiar with the mechanics of adjusting the tuning curve, it is time to adjust the
tuning to match your tuning criteria. You may want the 6:3 octaves in the low bass to be as pure as possible
and the 4:1 double octaves in the treble to be as pure as possible. Do that by selecting these intervals in the
selection boxes located around the adjuster arrows. Open these drop-down selection boxes by tapping on the
little triangle after the interval ratio. Scroll through the choices and tap on 6:3 in the left selection box and 4:1
in the right selection box. TuneLab will remember your preference and these intervals will always be selected
for you when you start a new tuning. In addition, the interval selections for each tuning will be stored in the
tuning file, so you can have different interval selections with each tuning file.
Now that you have the proper intervals selected, the deviation curve (the lower curve) shows you how your
selected intervals will sound. The goal is to adjust the tuning curve until the deviation curve is as straight as
possible at both ends. You will notice that the right-hand adjuster buttons control the shape of the treble end
of the tuning and hence the shape of the treble end of the deviation curve. If the deviation curve is bowed up
in the middle, press the down adjuster arrow. If the deviation curve is bowed down in the middle, press the up
adjuster arrow. If you have the default automatic adjustment of the endpoints of the tuning curve enabled, the
ends of the deviation curve will always be at zero. Your goal in adjusting the shape is to get as much of the
deviation curve as possible to lie close to zero.
When you adjust the shape of the bass end of the tuning curve you will notice that the deviation curve moves
in the opposite direction as the tuning curve. This behavior is a consequence of the way the deviation curve is
defined. If the bass end of the deviation curve is bowed up in the middle, press the up adjuster button. If the
bass end of the deviation curve is bowed down in the middle, press the down adjuster button.
The Zoom function was mentioned earlier in relation to containing the tuning curve. The Zoom function also
scales the graphical display of the deviation curve.
When you get the deviation curve to look something like the one here, then
you are done. Notice that the deviation curve does not hold very close to
zero at the transition in the middle. That is normal and expected. As you
move from the bass to the treble, your criterion for a good tuning gradually
changes from making 6:3 octaves beatless to making 4:1 double octaves
beatless. Midway through that transition the 6:3 octaves will be a little narrow and the 4:1 double octaves will
be a little wide. It is impossible to get both intervals to be beatless at once throughout the scale. You should
find that in the vicinity of the transition you have other criteria for a good tuning (such as 4:2 single octaves)
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and those criteria will be satisfied quite well. The criteria for a good tuning that we suggested here are just a
starting point. Some TuneLab users report getting better results by selecting 4:2 octaves in the treble. Feel free
to experiment to find the settings that most closely correspond to your tuning style.
Saving the Tuning File
After the tuning curve has been adjusted to your satisfaction, exit from the tuning curve adjuster by tapping on
Done. If you want to save this tuning file for later recall, now would be a good time to do so. Save the tuning
file by tapping on the Save Tuning File icon (the diskette symbol shown to the left) and entering the name of
the tuning file. Use a name that is short enough to fit in the space allotted in the current settings box but
long enough to remind you which particular piano this is so that you can recognize it in a list of other
tuning files. If you are tuning a lot of new pianos of the same brand you may decide to keep only one tuning
file that you use for all pianos of a particular model. If you have the time, it is best to measure inharmonicity
and adjust a tuning curve for each piano. However new pianos of the same model do not vary that much and
for all but the most critical uses, a generic tuning may be acceptable. You can delete tuning files using the File
Explorer program. See Chapter 1 for information on organizing your tuning files into different folders and on
how to save comments associated with any tuning file.
Beginning to Tune
Now that you have a custom tuning file for this piano and that tuning file has been saved, you can turn your
attention to actually doing the tuning. Because aural tuning always starts by setting a temperament, aural tuning
sequences start in the middle of the scale and work downwards and upwards from there. When tuning to a
calculated TuneLab tuning, you need not conform to this sequence. You can tune in any order that you want.
Although you may not be considering a pitch raise at this time, remember that you will get less interaction
between notes if you tune from the low bass to the high treble in order. That is the recommended sequence.
However there is at least one possible advantage to tuning the treble first. Tuning the treble requires more
concentration and it might not be a good idea to leave the treble to the end when you may be tired. In any
case, the decision on the tuning sequence is yours to make.
If tuning the bass first, select A0. Play the A0 on the piano and watch for a peak on the spectrum display. The
bass requires some special consideration. Because you are tuning to a high partial, it is quite easy for a wrong
partial to masquerade as the correct partial if the note is seriously mis-tuned. When in doubt, use aural methods
to verify that the note is at least in the ballpark before trusting the spectrum display or the phase display. One
way to confirm that you are tuning to the correct partial is temporarily to select a different partial. If several
partials appear at the same relative position in the spectrum display, then you probably have the correct partial.
If you do not see a very prominent peak in the spectrum display, it is not necessarily a cause for concern. The
phase display will work even with partials that are almost too small to see in the spectrum display. Especially in
the bass, feel free to select a different partial on the fly if you are having trouble getting a reasonable indication
on the current partial. You can tap on the partial-changing buttons shown
on the left. If you have enabled auto partial selection in Edit Options, then
TuneLab will search for a stronger partial as you tune and switch partials automatically if one is found.
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We recommend that for your very first tuning with TuneLab you leave auto note switching disabled. That way
you will not be confused by unintentional note switches. Later on, you can enable auto note switching to speed
up your tuning. For now you can manually switch notes by tapping on the spectrum display.
When you finish the monochord section of the bass and come to the bichords, always mute one of the strings
before tuning the other string in the unison. After one string is tuned, remove the mute and tune the unison
aurally. There are times when machine tuning of the unisons is an advantage, but those instances are usually in
the high treble. In the bass there are many partials that need to be balanced. Tuning these unisons aurally
allows you to make the needed compromises to get the best-sounding unisons. Also, aural unison tuning is
faster than using the machine.
Proceed up through the bi-chords and into the tri-chords. Here you can mute the outside two strings and tune
the middle string. Then move the right mute over one note to expose the right-hand unison. Tune that unison
aurally and then move the left-hand mute over one note. That will expose the left-hand unison and also remute the right-hand string. In case your right-hand unison was off at all, it is better to tune the left-hand unison
to the middle string than to tune the left-hand unison to the combination of the middle and right-hand strings
sounding at once. Also, having all three strings sound at once increases your chances of having to deal with
false beats. So always tuning unison strings in pairs is recommended.
Continue tuning through the high treble. Here you may have some trouble with the phase display. Even
though TuneLab has artificially slowed down the movement of the phase display in the high treble, false beats
together with a short sustain can produce a confusing picture in the phase display. It is here that we
recommend that you switch over to using the spectrum display. The resolution of the spectrum display is in
term of cycles per second, not in terms of cents. Therefore the cents-wise resolution of the spectrum display
gets better and better the higher you go in frequency. You can see this by noting the jagged look of the
spectrum display around A-440 in the picture in Chapter 1 as compare to the somewhat more precise look of
the graph following that one which is based around C7 (at about 2100 Hz). Therefore, in the high treble we
recommend just trying to get the peak to be centered on the central red line in the spectrum display.
Using Auto Note Switching
You can use auto note switching to make tuning easier. To enable this feature, tap on field in the bottom
middle of the Current Settings box (normally showing “manual note”) to bring up the note switching menu.
Choose “auto up”. When auto note switching is enabled, TuneLab will be constantly listening for nearby
notes; and when it hears one, it will switch to it. Auto note switching can be enabled for switching up, down, or
in both direction. The range of auto note switching is up to 300 cents from the current note. If you use aural
checks while tuning, be aware that auto note switching may occur while you are doing these checks. If an
unintended auto note switch occurs, simply switch back to the correct note manually.
When over-pull mode is also enabled, or when higher treble notes are selected, auto note switching requires a
“trigger”, which is a sudden rise in volume, such as you would get when playing a note after some silence. At
other times, auto note switching is less demanding, and will switch when the pitch changes without a trigger
event. If TuneLab doesn’t switch when you want it to, wait for some silence, and then play the note again.
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Chapter

All About Offsets

TuneLab uses a variety of offsets, specified in terms of cents, where an offset of 100 cents expresses the
difference from one note to the next. There are 1200 cents in an octave. The offsets in effect are all displayed
in the Current Settings box, as shown in Chapter 1. TuneLab combines them to calculate the desired pitch for
each note. In normal tuning, only the tuning curve offset is used and the other offsets are all zero.
Temporary Offset (or Over-pull)
This is either the “temporary” offset (also just called the “Offset”), or the “over-pull” offset in over-pull
(pitch-raise) mode. When TuneLab is not in any special mode, you can adjust this offset in a variety of
ways. As shown on the left, the offset may be adjusted by tapping
on the phase display. The further from the center, the greater the
adjustment will be. You can also enter an offset directly using the
Enter Current Settings menu item under the Edit menu. Also you can tap on the offset display itself to
bring up a menu with which you can transfer the offset to the custom stretch for the current note, transfer
the offset to the basic offset, or zero the offset entirely. In over-pull mode, this offset is not adjustable by
the user. Instead this field shows the calculated over-pull offset. In preparation for a Tuning Exam, this
field shows the detuning offset when the detuning mode is selected. The temporary offset is not displayed
if it is zero. When it is displayed, it is highlighted to alert you to the possibility of an unintended offset.
The temporary offset can also be affected by Locking mode, which is described below. When Locking
mode is enabled, the offset automatically and continually adjusts itself to match to the pitch of the sound
that the microphone hears.
Custom Stretch
This is an optional note-by-note offset and is stored in the tuning file. It is rarely used, except when
recording an aural tuning for the Tuning Exam. It can be used to make note-by-note corrections to the
tuning curve. But if you find yourself making many such corrections, then you should consider readjusting
the whole tuning curve instead. This custom stretch can be set by a transfer from the temporary offset as
described above. This offset is not displayed if it is zero.
Tuning Curve Offset (or Stretch)
This offset comes from the tuning curve. It is calculated based on the adjustment of the whole tuning
curve, taking into account the partial that is selected and the inharmonicity.
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Temperament Offset
This offset is shown when an unequal (historical) temperament is selected. Then this offset shows the
temperament offset for the current note. The 12 temperament offsets are stored in the tuning file when it
is saved with an unequal temperament selected. The temperament offset can be changed by selecting a
different historical temperament, or by editing the offsets and making a new un-equal temperament file.
Basic Offset
This offset used to offset the tuning as a whole. It is most commonly used to change to a non-standard
pitch, such as A-442. Its effect is just like that of the temporary offset, except that it is not so easily
changed. Tapping on the temporary offset brings up a floating menu that allows you to transfer that offset
to the basic offset. Tapping on the basic offset itself brings up a menu that allows you to zero it.
Locking Mode
Locking mode is entered by tapping on the lock icon, as shown
here. When Locking mode is turned on, TuneLab shows a status
box that says “(trigger?)”. A trigger is a sudden rise in volume as
you would expect when a piano note is struck. If you want to activate Locking mode without a sound trigger
(such as when calibrating to NIST tones), you can do so by tapping the lock icon again. To cancel locking
mode, tap the current note display. When Locking mode is active, the amount of automatic offset adjustment
starts out high and then gradually reduces to a minimal level after about six seconds. You will notice that the
locking action appears sluggish after the locking mode has been activated for a long time. This behavior is by
design. When a note is first struck, the offset may have a long way to go to match the pitch from the
microphone. But after the locking has been in operation for a few seconds, the offset is mainly hunting around
some central value. If the note being sounded has some false beats, then the phase display may be a little
unstable. And, if the locking continued to pursue the unstable pitch with the same aggressiveness, it would
never settle down to a single value. But when the aggressiveness of the locking action is gradually reduced, the
offset will not wander as much and a more accurate reading can be taken. At any time during the locking
operation the aggressiveness of the offset adjustment can be reset to its initial maximum value by tapping again
on the lock icon in the toolbar.
Entering Offsets by Frequency
In the “Enter Current Settings” box (from the Edit menu), there are three offsets that are normally specified in
terms of cents. But you can alternatively specify these offsets by the pitch in Hz using the following formats:
A=442
F=524.35

(sets A4 to 442 Hz. For offset or basic offset)
(sets current note to 524.35 Hz. For offset, custom stretch, or basic offset)

The letter ‘F’ or ‘A’ may be entered as lower-case ‘f’ or ‘a’ as well, and the ‘=’ sign is optional. If the entry starts
with letter ‘A’ then the offset will be set to make A4 equal to the specified pitch. If the entry starts with the
letter ‘F’ (for “frequency”) then the following number is interpreted as the desired pitch of the currently selected
note and partial. This allows you to specify a frequency for some note besides A4.
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Chapter

Over-pull (Pitch Raise) Tuning Procedure

Over-pull tuning is sometimes called pitch raising. When large overall changes are made to the tuning of a
piano, the notes that you tune first tend to change as you tune later notes. Over-pull tuning mode compensates
for this change by setting the pitch a calculated amount beyond the desired pitch. In this way the settling that
occurs as later notes are tuned will leave the notes right where you want them. In many cases using just one
pass with over-pull tuning can take the place of tuning the piano twice.
Measuring Inharmonicity Before an Over-pull
When over-pull mode is activated you cannot measure inharmonicity. Therefore if you want to create a custom
tuning for the piano as described in the Chapter 2, you would have to measure the inharmonicity and adjust the
tuning curve before enabling over-pull mode. For small to moderate pitch raises, the normal inharmonicity
measurements will be sufficient. However, for extreme pitch raises, the act of pulling the string up to pitch will
change the inharmonicity of the strings. For such pitch raises, you are not going to get away with doing a onepass tuning anyway. So when you do the second pass, discard the old inharmonicity readings by starting over
with a new tuning file, and take fresh inharmonicity readings. In fact, you would probably be better off
skipping the inharmonicity readings on the first (extreme) pass and using a generic tuning file from a similar
model piano for that pass. Then only the final pass needs to be customized.
Enabling Over-pull Mode
If your pre-tuning evaluation of the piano convinces you that the overall
pitch change is large enough to need an over-pull, then you can enter overpull mode by using the over-pull icon in
the toolbar as shown on the right. A
dialog box like the one on the left will open up. Most of the time all you
need to do at this point is select Begin, but you can also use this
opportunity to set various preferences relating to over-pull. TuneLab will
remember your settings so you need only to enter them once. If you are
not going to change any of the settings, just select Begin and skip ahead to
the next section on Beginning Tuning in Over-pull Mode.
The first group of fields sets safety limits for over-pull in cents. You can
change these entries by tapping on the small triangle in the drop-down
selection boxes. The purpose of these overriding limits is to reduce the
likelihood of breaking strings in an extreme pitch raise. These limits do not
come into play in small to moderate pitch raises. They define the maximum over-pull in cents for two groups
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of notes. If the calculated over-pull is higher than the limit shown here, then TuneLab will use the specified
limit value and not the calculated value for over-pull. The other items in this dialog box are explained later.
Beginning Tuning in Over-pull Mode
Before each note is tuned in over-pull mode, TuneLab can listen to the note for one second to get a rough
measurement of its pitch. TuneLab keeps this information in a history list as described in Chapter 1, and uses
this information to calculate the over-pull offset. You can follow your progress through the over-pull sequence
by watching the status box that appears in Over-pull mode. Here is what you would see as TuneLab waits for
you to play the note, listens for one second, and then displays the results, at which time you can begin tuning
the note:

The first status box on the left is what you would see after changing to a new note or after requesting a remeasuring of the current note. When you play the note you will see the second status box followed briefly by
the third status box which will show what the measurement was for the current note. When you see the third
status box you may then begin to tune the current note in the usual manner. If it appears that TuneLab does
not always recognize when you play a note to be measured, remember that TuneLab is triggered by a sudden
rise in volume. You should have a short break in the sound before striking the note so that TuneLab will see a
clear difference between the silence and the sound of the note being struck. Then it will begin the
measurement.
If the measurement shown in the third status box looks unreasonable, then perhaps an extraneous sound
triggered the measurement before you actually played the note. If that is the case you can re-measure the
current note by using the measure icon in the toolbar. You can also start an over-pull measurement easily by
tapping anywhere in the over-pull status box. You can use your fingernail since it is such a big target. Every
time you request a re-measuring of the current note, the most recent measurement is removed from the history
list and TuneLab returns to waiting for you to play the note again. If you somehow get several bad readings in
the history list, you can remove as many entries as you like by repeatedly requesting a new measurement
without playing the note.
Faster Pitch Raising
To get the most accurate over-pull tuning, TuneLab normally measures every note automatically before it is
tuned. One way to speed up the process is by measuring only occasionally, by unchecking the “Measure Every
Note” option in the over-pull dialog box shown above. When automatic over-pull measurement is disabled in
this way, you decide when a note should be measured by explicitly starting an over-pull measurement as
described above. For those notes that you don’t bother to measure, TuneLab will assume the same
measurement for that note as for the previous note, and you can go directly to tuning as soon as you change
notes.
Another way to do a very fast pitch-raise is to use timed note switching, as described in Chapter 1, and do a
rough tuning only. Timed note switching will keep you from spending too much time on one note. You can
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tune without mutes and use the spectrum display, tuning roughly by moving the peaks for each string quickly to
the red line in the middle. This will be close enough for a rough first pass. If you have the time delay set to 9
seconds, then you can complete the first pass tuning in about 13 minutes. If over-pull is used on this first pass,
then perhaps the second pass can be done in normal mode.
How Over-pull is Calculated
You do not need to understand the exact formula for over-pull to take advantage of over-pull mode. TuneLab
performs the calculation automatically based on the history list. The history list is the list of measurements
taken before each note is tuned. The list is ordered from most recent to oldest. Only the most recent few
measurements are displayed, but these recent measurements are the most important.
The over-pull amount is an offset in cents that is added to any other offset or stretch values. The over-pull
amount is displayed in the upper right corner of the current settings box in the place normally used to display
the temporary offset (if there is one). Note: The use of the temporary offset is not permitted in over-pull
mode. If you must use an overall offset in over-pull mode, use the Basic Offset. The over-pull amount is
calculated by starting with the most recent few measurements in the history list. How many are actually used is
determined by the number that you have selected in the box shown when you first enabled over-pull mode. By
default TuneLab uses the last seven notes. Assuming that seven measurements are used, TuneLab takes a
weighted average of these seven measurements using weightings that give the most weight to the most recent
measurement and progressively less weight to the older measurements. Finally TuneLab multiplies the
weighted average by the over-pull percentage and uses the opposite of that number as the over-pull in cents
(subject to the safety limits, of course).
Changing Over-pull Percentage
The over-pull percentage may be changed as you tune in over-pull mode. To make such changes fast and easy,
tap on the right or left halves of the phase display with your fingernail. The initial default over-pull percentage
is 25%. The current over-pull percentage is always displayed in the current settings box when you are tuning in
over-pull mode. For small to moderate pitch raises, simply use 12% when tuning in the bass bridge and 30%
when tuning elsewhere. For more precise control of the tuning, use the following guidelines for over-pull
percentage. These guidelines assume that you will tune unisons as you go up the scale from A0 to C8.
bass bridge
tenor bridge to G5
G5 to G6
G6 to C8

12%
29%
29% increasing to 37%
37% decreasing to 14%

Using Auto Note Switching with Over-pull Mode
There are some special considerations that need to be taken into account when using these two features
together. If a pitch raise is more than 50 cents, the next note will sound closer to the current note, and
TuneLab will not recognize it as the next note. In that case, consider using timed note switching, as described
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in Chapter 1. But assuming that auto note switching is feasible, it requires a “trigger” to switch, which is a
sudden rise in volume, such as you would get when playing a note after a brief period of silence. This is to
reduce the chance of mistaken note switches in over-pull mode. If an unintended note-up switch does occur,
and if you correct it by manually switching back down to the previous note, then TuneLab will automatically
remove any over-pull measurements that may have been entered into the history list after the mistaken auto
note switch. Also, there is an option called “Instant Measuring” in the over-pull dialog box. If you check
Instant Measuring, then the sound that triggers an auto note switch will also be measured automatically for the
over-pull calculation. If you do not check Instant Measuring, then you will need to play the note once to switch
notes and again to measure it. Then you can start tuning the note.
Saving the Entire History List
After tuning a piano in over-pull mode, the entire collection of over-pull pitch measurements made before each
note was tuned may be saved to a file for later off-line study. From the Tools menu, select Save Over-pull
Measurements. You will be prompted to enter a file name. The entire history list will be written in text
format to the file that you specify. The average of all the over-pull measurements are shown in the over-pull
dialog box by the “Avg. = x.x” field.
When to Tune Unisons in a Pitch Raise
There are two schools of thought when it comes to this issue. You can tune unisons as you go, or you can use
a strip mute and postpone the tuning of unisons until the end. Aside from any general considerations that may
enter into your decision of which way to choose, there are special considerations relating to Over-pull mode.
Over-pull works by estimating how far the pitch of a string will fall as the rest of the piano is tuned. The
current note is then tuned sharp by that same amount. If you tune unisons as you go, the notes below the
current note will all have been tuned and the notes above it will not have been tuned yet. Therefore the current
note will be affected only by the subsequent tuning of the notes above it. On the other hand, if you use a strip
mute and postpone tuning unisons, the outer strings of the notes below the current note will not have been
tuned yet. Therefore the current note will be affected both by the tuning of notes that lie above the current
note and by the tuning of the unisons of the notes that lie below the current note. This subjects the current
note to the almost twice as much pitch-fall after it is tuned. To compensate for this extra expected drop in
pitch, you would have to use a higher over-pull percentage.
The guidelines shown for over-pull percentage are based on the assumption that you will tune unisons as you
go. If you want to use a strip mute and tune unisons later, then plan on using a somewhat higher over-pull
percentage. Warning! This may increase the chance of breaking strings on extreme pitch raises. Use the overpull safety limits to prevent extreme over-pull.
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Chapter

Calibration Procedure

Chapter 1 described the need for calibration. This chapter takes you through the process of actually doing a
calibration. Normally you need to do a calibration only once when you first install TuneLab on your laptop or
Pocket PC. The results of the calibration are stored permanently and used every time you run TuneLab.
A Trusted Source of Pitch
To do a calibration you need to have a trusted source of pitch. The most accurate source of pitch that you can
get is the National Institute of Standards and Technology (NIST). This agency of the U.S. government has a
telephone service and shortwave radio service that disseminate standard time and frequency. The telephone
service is free of charge (after you pay the normal long-distance charges), and the shortwave radio service may
be heard on 2.5, 5, 10, 15, and 20 MHz. Another source of accurate pitch is a Sanderson Accu-Fork or AccuTuner. In most areas of the U.S. the telephone dial tone contains an A-440 that might be used for calibration,
but this frequency is not certified by the phone companies and may be in error. The procedure described here
involves the use of the NIST standard frequency service.
NIST Broadcast (and Telephone) Schedule
The NIST standard frequency service is broadcast on shortwave radio station WWV on the frequencies listed
above. The audio portion of this broadcast is also available by telephone by calling (303) 499-7111 in Colorado.
This is a very popular number. NIST reports that they get over two million calls per year. In order to use these
services effectively, you need to know something about the schedule for WWV. The following schedule is
followed each hour. It shows what tones are present during each minute of the hour. When a tone is present,
it is present for the first 45 seconds of the minute and it is silent for the last 15 seconds.
0:
1:
2:
3:
4:
5:
6:
7:
8:
9:

--600
440
----600
500
600
-----

10:
11:
12:
13:
14:
15:
16:
17:
18:
19:

--600
500
600
------600
--600

20:
21:
22:
23:
24:
25:
26:
27:
28:
29:

500
600
500
600
500
600
500
600
500
---

30:
31:
32:
33:
34:
35:
36:
37:
38:
39:

--600
500
600
500
600
500
600
500
600

40:
41:
42:
43:
44:
45:
46:
47:
48:
49:

500
600
500
---------------

50:
51:
52:
53:
54:
55:
56:
57:
58:
59:

----500
600
500
600
500
600
500
---

Although the 440 Hz tone in minute #2 is tempting, do not try to use it. That pitch is only present for 45
seconds each hour. The difficulty in calling at just the right time and the shortness of the tone make this choice
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inadvisable. Instead you can use the 500 Hz and 600 Hz tones. The telephone service will disconnect you after
three minutes, so make sure that when you call you have everything set up and time your call so that you will be
assured of at least three minutes of 500 Hz or 600 Hz tones. If you happen to be closer to Hawaii than to
Colorado, you can receive WWVH by shortwave radio or by calling (808) 335-4363 in Hawaii. For more
information on both of these sources, see the website:
www.boulder.nist.gov/timefreq/stations/iform.html

Special NIST Tuning File for Calibration
To use the NIST standard frequency service to do a calibration on your TuneLab, start by opening the tuning
file NIST-303-499-7111-C5-D5 which was installed with TuneLab. This tuning file contains special custom
stretch offsets for the notes C5 and D5 so that they come out to 500 Hz and 600 Hz respectively. The name of
the tuning file also contains the Colorado phone number for the NIST service as a reminder. If you select C5
and then D5 you can see the frequency reported as 500 Hz and 600 Hz to correspond with the tones from
NIST. Do not make any changes to this tuning file, and of course do not try to tune a piano with it!
Manual Locking onto NIST
When TuneLab begins listening to an NIST tone, your goal is to trim the offset of TuneLab so that the phase
display is perfectly stopped. There are two ways to do this - manually and automatically. The manual method
is more accurate but the automatic method may be quicker to use. In either case, you will have to select C5 or
D5 depending on which tone is coming from NIST. Don’t bother trying to figure out which tone is present
from the broadcast schedule. Just use trial and error. Select C5. If the spectrum display doesn’t show a peak
near the central red line then you probably have the wrong note, so switch to D5. If you run out of tone before
you can get the phase display stopped, then switch to the other note because the 500 Hz and 600 Hz tones
alternate each minute. If you get the offset trimmed for 500 Hz, that same offset will be correct for 600 Hz.
Trim the Offset as described in the Chapter 3 (“All About Offsets”). While TuneLab is listening to the NIST
tones from the telephone, the goal is to make the phase display be absolutely stopped by adjusting the offset to
within a small fraction of a cent. Adjusting the offset by .01 cents will produce a change so small that you will
not be able to tell that anything has changed unless you observe the phase display for more than 15 seconds, so
don’t worry about getting that last hundredths place right unless .01 cent absolute tuning accuracy is really that
important to you. For most purposes, .05 cents is close enough. If the phase display is moving to the right,
then you should make the offset higher (tap on right side of the phase display). If it is moving to the left, then
make the offset lower (tap on the left side of phase the display). The slower the phase display moves the finer
the adjustment that is needed. When the phase display is as stopped as you can make it, you are done with the
adjustment (but not with the calibration). You may hang up the phone at this point and go to Completing the
Calibration.
Automatic Locking
As an alternative to the manual adjustment of offset that was just described, you can use the Locking mode in
TuneLab, as described in the chapter “All About Offsets”. When this mode is active, TuneLab listens to the
sound coming in and automatically adjusts the offset to make the phase display come to a complete stop. The
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process is somewhat sensitive to noise; but the automatic locking mode may be easier and faster. When locking
to a tone on the telephone, there may not be a rise in volume sufficient to be detected as a trigger. You can
force Locking mode to become active without a trigger by tapping on the Lock button again.
When Locking mode is active (as indicated by the Locking status box) the adjustments to the Offset will
proceed continuously, and you should see the results of that adjustment in the upper right of the Current
Settings box. If the sound that TuneLab is supposed to lock to is interrupted, TuneLab will continue to
attempt to lock onto whatever sound it hears. If it hears just normal background noise, the offset will seem to
change randomly. Therefore it is important to disable Locking mode before removing the tone. In the case of
the NIST tones, if the tone stops before you have achieved a satisfactory lock, then you should disable Locking
mode as soon as possible (by tapping on the current note display) and wait for another tone to begin. Since the
NIST tones alternate between 500 Hz and 600 Hz, you should take this opportunity to switch between C5 and
D5.
If the phase display appears to have stopped completely, then turn off Locking mode. This is done by tapping
on the current note display. If you have time, make one final check of your Offset adjustment after turning off
the locking mode. If the phase display is still stopped, then you are done listening to the NIST tone and you
can hang up the phone and proceed with Completing the Calibration.
Completing the Calibration
At this point you should have a temporary offset showing in the Current Settings box. This is the offset that
caused the phase display to come to a stop when TuneLab was listening to NIST. You should also have a
frequency showing in the current settings box. If you were locked onto one of the NIST tones, this frequency
will be very close to either 500 Hz or 600 Hz, but it will not be exactly 500 Hz or 600 Hz unless the Offset that
stopped the phase display just happened to be zero. The reason for this difference is that TuneLab has not
been calibrated yet; so what it thinks is 500 Hz is not necessarily exactly 500 Hz. Do not change notes or
anything else but proceed directly to finishing the calibration.
Tap on the frequency value in the Current Settings box and select Calibrate to External Ref.. A box will
appear with a field labeled “actual frequency”. If this is a NIST calibration, then TuneLab will fill in this box
with 500.00 or 600.00 depending on which note was last selected. If the selected note is A4, then TuneLab will
suggest exactly 440.00. Otherwise TuneLab will suggest the frequency that appeared in the current settings
box, rounded to the nearest 1 Hz. This may be exactly what you need if the calibration error was small. If not,
you may need to enter the correct frequency. If the calibration tone came from NIST, then the correct actual
frequency should be 500.000 or 600.000, depending on which tone TuneLab was listening to last. Make sure
that this exact frequency is entered and then click on OK. The calibration is now done. At this point TuneLab
will automatically zero out any offset that you may have had prior to the calibration, because it is no longer
needed, now that the new calibration is in effect.
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NIST Calibration Checklist
(1) NIST tuning file is loaded.
(2) C5 is selected with 500 Hz showing.
(3) Spectrum display zoom set to +/- 260 cents (so you can see both C5 and D5 at once)
(4) Telephone sound can be heard by the microphone.
(5) NIST schedule shows tones are available for the next few minutes.
(6) Place the call to NIST.
Before calling NIST, make sure you can situate the telephone so that TuneLab can hear the tones. You can use
the dialtone just to verify that it will work. Try to situate the telephone receiver directly over the microphone in
your computer so that you are not holding it in your hands, because movement of the receiver will create noise
that could interfere with the sounds TuneLab is trying to hear. When the call is answered, listen for a tone.
Remember that the last 15 seconds of every minute has no tone, so you may have to wait up to 15 seconds.
When a tone is heard, determine if it is 500 Hz or 600 Hz by selecting C5 or D5 until you see an indication in
the phase display or the spectrum display. As soon as you find out which tone is being heard, use the Locking
mode or manually adjust the offset in order to make the phase display stop. Remember that NIST will
disconnect you after three minutes, so plan your usage accordingly. Finish the calibration as described above.
Verifying Calibration
After a calibration is complete, you may wonder if it completed properly. You can check this in several ways.
From the Help menu, select About TuneLab Pocket. A box will appear that shows, among other things, the
actual sample rate. This is the actual end product of doing a calibration. The actual sample rate is stored in
your computer to be used every time you start up TuneLab. If you are curious as to how far off TuneLab
would have been without calibration, compare the actual sample rate shown in the About box with the nominal
sample, which is 22,050. Now that you have done a calibration, it will not matter that the actual sample rate is
different from the nominal rate because TuneLab knows about the difference, and is taking it into account in all
its calculations. Another way to check calibration is to go back to NIST or some other trusted source of
known pitch. Select the note and offset that makes the phase display stand still. If TuneLab is properly
calibrated, the frequency display in the current settings box should be absolutely accurate and it should agree
with the frequency of the trusted source.
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Chapter

Special Functions
Split Scale Mode (Spinets)

Most spinets (and some small grands, like the Yamaha GH-1) are difficult to tune because they have a large
jump in their inharmonicity - usually at the point where the scale makes the transition between wound strings
and plain strings. TuneLab has a special facility just for such pianos. This facility is called the "Split Scale".
If you want to use the Split Scale, then do this:
1. Take inharmonicity measurements of the two consecutive notes at the transition. (If the inharmonicity
constants from these two measurements are within 50% of each other, then discard one of the readings
and do not use Split Scale mode.)
2. Measure three other notes below the transition.
3. Measure three other notes above the transition.
This pattern of inharmonicity measurements tells TuneLab to use the Split Scale tuning curve, and it also tells
TuneLab exactly where the transition is.
An alternative way to start a Split Scale tuning file is from the New menu. Select “New Split Scale Tuning
File”. TuneLab will then ask you for the location of the break where you expect the inharmonicity to jump
(typically the break between wound strings and bare wire strings). Once TuneLab knows this, it will figure out
which notes you should measure and sequence through those measurements automatically.
After you have measured inharmonicity as described above, you can invoke the tuning curve adjuster. The
tuning curve adjuster shows when TuneLab is in Split Scale mode by placing a vertical line on the tuning curve
and the deviation curve, as shown in the picture below. This vertical line shows the location of the break
between the two parts of the split scale. If you do not see this vertical line in the tuning curve adjuster, then
TuneLab is not in Split Scale mode. If you expected to see Split Scale mode, then review your list of
inharmonicity readings. You will probably find that you have either:
1. less than four total inharmonicity readings below the break, or
2. less than four total inharmonicity readings above the break, or
3. more than one pair of consecutive inharmonicity readings.
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If any of these conditions are true, then TuneLab will not go into Split Scale mode. For example, if you are
tuning a Baldwin Acrosonic spinet, which has a break at F#3/G3, then you could invoke Split Scale mode by
measuring inharmonicity at:
B0 G1 E2 F#3 G3 C4 A4 G5
When TuneLab is in Split Scale mode, the tuning curve adjuster buttons have a direct effect on the portion of
the tuning curve above the transition. We recommend that you select 4:1 double octaves in the treble side of
the tuning curve adjuster, and 6:3 single octaves in the bass side.
This is what TuneLab does in Split Scale mode. The usual continuous
model for the inharmonicity of the whole piano is broken up into two
separate models - one for the portion of the scale below the transition and
one for the portion above the transition. When you adjust the tuning
curve, you will be directly adjusting only the portion of the tuning curve
above the transition. The portion of the tuning curve below the transition
will be automatically adjusted to give perfect 6:3 single octaves, if 6:3
octaves are what you selected for the bass. If you selected something else
for the bass, then TuneLab will adjust the bass for 6:3 single octaves at the
top of the bass and whatever you selected at the bottom of the bass.
TuneLab will blend smoothly between these two intervals as you move
down the scale in the bass. If you select 6:3 single octaves for the bass, then
the deviation curve will show exactly zero cents for the entire left half of the
curve. When adjusting the tuning curve in Split Scale mode, we recommend
the fully automatic method of adjustment as shown here.
If you choose one of the manual modes for adjusting the tuning curve, then be advised that when adjusting the
tuning curve in Split Scale mode, the adjuster buttons for the left half of the curve do not actually change the
left half. Instead they change the portion of the treble tuning curve as it would be if it were extended into the
bass. Nevertheless, it may still be useful to make these adjustments because the interaction with the treble side
can improve the length of the flat portion of the deviation curve at the treble end. The image shown above is
what a good tuning curve and deviation curve might look like in Split Scale mode for a Baldwin Acrosonic
Spinet. Note the vertical line which indicates Split Scale mode.
The large deviations in the middle of the deviation graph are to be expected. Pianos that need Split Scale mode
tend to have high inharmonicity just above the break. Although 4:1 double octaves in this region may be quite
wide, 4:2 single octaves will be just about right. You can check the condition of 4:2 single octaves by
temporarily switching to 4:2 in the treble. Make sure you switch back to 4:1 double octaves before making any
further adjustments. After you have adjusted the tuning curve so that the deviation curve looks like the one
above, focusing mostly on the far right end of the curve and how it sticks close to zero, then exit from the
tuning curve adjuster and tune the piano as usual.
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Tuning Exam Mode
From the Modes menu you can enter or leave Tuning Exam Mode. When this mode is active, the status box
on the right side of the current note display is used to display the total offset, rounded to the nearest 0.1 cents,
in keeping with the requirements of the PTG Tuning Exam. This display may be used to gather tuning offsets
manually. Also, Tuning Exam Mode forces the use of the proper partials, as specified by the PTG Tuning
Exam. In addition, there is a grading facility for comparing an examinee’s tuning with a master tuning. See the
separate document on using TuneLab in the Tuning Exam for details.
Making Temperament Files
Historical temperaments were described in Chapter 1. They are opened and attached to the current tuning
using the Tools menu. If you want to use a temperament that was not provided with TuneLab, you can create
your own new temperament files using New Temperament File from the New menu. All you need to know
is the 12 offsets that define the temperament. After you enter the 12 offsets, you will be prompted to enter a
file name for the new or modified temperament. When you make a new temperament file, you can then select
it into any tuning curve just like the original temperament files.
Measuring Voicing
As a by-product of measuring inharmonicity, TuneLab creates a picture of
the relative amplitudes of the various partials that were measured. All the
partial amplitudes are rated in proportion to the strongest partial, which is
rated at 100. The voicing display shown to the left is available by selecting
the Voicing menu when an inharmonicity result is being displayed. Notice
there are two sets of horizontal bar graphs - one white and the other black.
The white bars show the amplitudes for the current measurement. The
black bars show the amplitudes for a previously-saved measurement (using
the “Save for comparison” pushbutton). In example shown, the previous
measurement was made with a forté blow, and the current measurement
was made with a softer blow. This resulted in different relative amplitudes,
especially for the second partial. Keep in mind the limitations in the use of
this voicing measurement. The exact pattern of amplitudes depends greatly
on the quality and the placement of the microphone, and on the strength of
the hammer blow.
Measuring Sustain Time
Another by-product of an inharmonicity measurement is the sustain time, which is described as the length of
time that a note sounds before fading so much that it cannot be heard. Although this definition is imprecise
and subjective, piano rebuilders often need some measure of sustain time to evaluate the quality of the bridge
and soundboard. The calculated sustain time is shown along with the results of the inharmonicity
measurement. To measure sustain time, follow the normal instructions for measuring inharmonicity.
However, there are several precautions regarding measuring sustain time.
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One precaution is to turn off automatic gain control on the microphone, if your Pocket PC offers such an
option. Normally, automatic gain control would be a good thing because it brings up the level of the sound as
the note decays, thus giving TuneLab more signal to work with. But automatic gain control will make the notes
appear to sustain much longer than they really do, so the calculation of sustain time will be invalid. If you do
change automatic gain control settings, you will have to switch temporarily to sound generating mode and back
to listening mode for the change to take effect
Another precaution is to be aware of the sound level as you strike the note. If the level reaches 100% for
too much of the phase of the inharmonicity measurement, then no sustain time will be reported. Use the
microphone overload indicator, as described in Chapter 1, to avoid too loud of a sound. You can also
preview the sound level by looking at the mic level indicator on the Help - About screen. Learn how
hard you must strike the note to achieve an initial 100% level, or thereabouts. A brief period of 100%
level is OK as long as the level drops below 100% shortly thereafter.
Finally, make sure that the correct note is selected when you measure sustain time. Although the sustain
calculation is not pitch-sensitive, the total sampling time does depend on which note is selected. TuneLab
assumes a shorter sustain for higher notes, as you can see by noting the differences in the inharmonicity
sampling times.
Auto Partial Selection
As stated in Chapter 1, the selection of which partial is used for each note can be modified by editing the table
of partials as a whole, or by making individual on-the-fly changes. Sometimes individual bass strings are found
to be weak in the pre-selected partial, making it difficult to tune them. You could manually try different partials,
or you can let TuneLab change to a different partial by enabling the option for automatic partial selection. This
option can be found under Edit Options. You specify a note below which automatic partial selection may
occur, and how high a partial you will allow to be selected automatically. The default is to disable automatic
partial selection completely. If you select a higher limiting note in your Options, then the lower notes will have
automatic partial selection enabled.
When automatic partial selection is enabled for a note, then the partial selection may change during the first few
seconds after you switch to that note. TuneLab will not change partials unless it finds a qualified partial that is
at least twice as strong as the currently selected partial. TuneLab will only change partials once for each note
switch. If an automatic partial change does occur, that change is treated exactly the same as if you had made
the change on the fly manually. In particular, if the Persistent Partials option is enabled, the change is
immediately incorporated into the current tuning file.
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Chapter

Menu Items and Options
Here is an item-by-item list for TuneLab Pocket.

Main menu
New
Tuning File - clear out any existing tuning file data and loads from DEFAULT tuning file.
Split-Scale Tuning File - ask for location of break, then start new split-scale tuning file.
New Temperament File - allows you to change the 12 offsets of a historical temperament, or to

enter a completely new temperament and save it to a file
Edit
Enter Current Settings - allows you to enter exact values for offset, custom stretch for the current

note, basic offset, and over-pull percentage.
Edit Inharmonicity Constants - Review and possibly edit the inharmonicity constants that resulted

from inharmonicity measurements. (Not generally needed)
Change table of partials - allows you to review and possible change the table of partials currently in

use. This table will be saved with the current tuning if you save the tuning file.
Zero all custom stretch - Use this function to remove all Custom Stretch values from the current

tuning. This will not affect the template tuning curve or the historical temperament (if any).
Edit Options - allows the setting of various options, listed later
View
Spectrum Zoom Wide - shows many partials at once
Spectrum Zoom 260 cents - shows 260 cents around the current note and partial
Spectrum Zoom 130 cents - shows 130 cents around the current note and partial
Spectrum Zoom 50 cents - shows 50 cents around the current note and partial
Exam Mode Offset - selects correct partials for RPT tuning exam and displays offset rounded to the

nearest 0.1 cents for recording master tunings and examinees’ tunings.
Exam Detuning - prepares a piano for the tuning exam by using specific offsets.
Exam Scoring - compares the current examinee’s tuning with a previously recorded master tuning.
Comments for this tuning - displays comments that you previously stored for the current tuning

file, or allows you to edit or enter new comments.
Tools
Temperament Select - lets you choose an existing unequal temperament file.
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Temperament Cancel - returns the current tuning to equal temperament.
Save Over-pull Measurements - saves all the measurements to a file for off-line analysis.
Help
About TuneLab Pocket - version information and a microphone level indicator.
Help Topics - display the TuneLab help file.
Register - allows you to enter license data to convert the free trial version to the paid version.
Close - Exit from TuneLab. TuneLab will prompt you if you need to save a tuning file first.

Tuning curve editor
Edit
Undo Changes - returns the tuning curve adjustment to the way it was when the tuning curve editor

was entered.
Freeze Custom Offsets - enables or disables the mode whereby the effect of custom offsets

remains fixed when the template tuning curve is adjusted. The setting of this mode does not
matter unless you are adjusting a tuning after establishing some Custom Stretch values.
Manual Adjust - makes all four sets of adjuster arrows visible and requires that you use them to
adjust the tuning curve.
Auto A0, C8 Adjust - makes only two sets of adjuster arrows visible and causes the overall stretch in
the bass and the treble to be calculated automatically. You only have to adjust the inner arrows to
control the shape of the tuning curve.
Full Auto Adjust - removes all adjuster arrows and calculates all aspects of the tuning curve
automatically based on the selected intervals and the inharmonicity measurements.
View
Cents - selects the cents display mode for the deviation curve.
Beats - selects the beats display mode for the deviation curve.
Zoom - toggles between original scaling and scaling that just contains the graphs in the available space.
Done - exits from the tuning curve editor back to the main screen.

Tapping on Offset in Current Settings box
Zero This Offset - sets the temporary offset to zero.
Transfer to Custom Stretch - transfers the offset to the custom stretch for the current note.
Transfer to Basic Offset - transfer the offset to the basic offset.
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Tapping on custom stretch in Current Settings box
Zero This Custom Stretch - sets the custom stretch for the current note to zero.

Tapping on basic offset in Current Settings box
Zero Basic Offset - sets the basic offset to zero.

Tapping on frequency (Hz) in Current Settings box
Calibrate to External Ref - Choose this item after you have matched TuneLab to an external frequency

source of pitch, such as NIST tones. This same menu item can be used to perform a listening-mode
calibration or a tone-generating mode calibration, depending on what mode is in effect at the time this
menu item is used.
Tapping on note switching status in Current Settings box
Manual only - allow only manual note switching.
Auto Note Up - enables auto note switching in the upward direction.
Auto Note Down - enables auto note switching in the downward direction.
Auto Note Up or Down - enables auto note switching in either direction
Timed up - enables timed note switching to the next higher note.
Timed down - enables timed note switching to the next lower note.
Auto Measure - sequences through pre-defined list of notes to measure for inharmonicity.

Options (in Edit Options box)
Use wide traces in graphs - makes traces three pixels wide instead of one pixel in the spectrum display

and, in the case of square screens or landscape mode, in the tuning curve adjuster graph.
Warn about tapping on phase display - This option warns you when you are about to change the
offset by tapping on the phase display. After the first warning, there are no more warnings unless you
stop using the phase display for that purpose for 30 seconds. When this option is disabled, tapping on
the phase display produces an immediate change in the offset with no warning.
Make partial changes persistent - remembers in the tuning file any changes made to the selected
partial using the partial-changing icons in the toolbar. If this option is not checked, then all such
changes are temporary, and the partial selections in the tuning file stay as they are.
Auto Partial Selection - specifies which notes, if any, should use automatic partial selection, and which
partials should be allowed to be selected automatically. This option is for the lowest bass notes. See
Chapter 6 for details. The default is for no auto partial selection.
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Timed note switching time - sets the time in seconds at which TuneLab will switch to the next note if

timed note switching is enabled.
Normalize Historical Temperaments - allows the selection of three types of normalization: none (as

is), normalize so that A=0, and normalize so that the average offset=0. The normalization shifts all 12
offsets for tuning, but does not change the original offsets in the tuning file or the temperament file.
Measure Sequence - tapping on this button brings up a screen on which you can specify (by tapping)
which notes are in or out of the sequence of notes to be measured when a new tuning file is started.
Phase Display Options
Speed Factor - scales the speed of the phase display for all notes.
Switch to Cents at… - specifies the note at which the speed of the phase display switches to cents.

Below this note, the speed of the phase display is based on beats. One beat of pitch error means one
complete cycle of the phase display (if Speed Factor is set to 1). Above the specified note, the phase
display speed represents the pitch error in cents. The higher you put this changeover point, the faster
the phase display will be for the higher notes.
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